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C H A P T E R  1

Quick Start

Robcomm3 is a Windows-based software application designed for use with
the RAPL-3 robot programming language. Robcomm3’s integrated
development environment allows you to:

•  create and edit robot programs as source files.
•  compile source files into object files.
•  transfer files between the computer and the controller.
•  simplify compiling and transferring with the application setup feature.
•  communicate interactively with the controller using the terminal window.

Basics
This is a quick summary of the basics of Robcomm3.

Function Button Drop-down Menu Comments

Edit Program File/New  or

File/Open

Opens a program in an
editor window for editing.

Set Up App Application/New App or
Application/Open App
and
Application/Setup

Automates compiling a
program and sending a
program to the controller.

Compile Program Application/Compile Compiles a program.

Transfer File
(from within App)

Application/Send Sends a program to an
app directory on the
controller.

Transfer File
(without App)

C500/File Transfer Sends/retrieves any file
to/from the controller.

Communicate
with Controller

C500/Terminal Opens terminal to
controller. Use system
shell or ash commands.
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C H A P T E R  2

Installation

This chapter describes all procedures that you need for installing and
configuring Robcomm3.

Preparing to Install
Before installing Robcomm3, ensure that you have the proper hardware and
software.

Computer
Recommended specifications can be exceeded where available.

Recommended Minimum

CPU Pentium 486

Speed 90 MHz 66 MHz

RAM 16 Mb 16 Mb

Operating System Windows 95 or
Windows NT 4.0 or higher

Drive for Installation Stand-Alone Robot 3.5 inch diskette

POLARA CD-ROM

Controller
The robot controller must be able to run CROS-500.

•  If you purchased a controller for a CROS/RAPL-3 system, your controller
meets CROS requirements. It is either:

•  C500B for an F3 arm, or

•  C500 (with a recent serial number) for an A465 or A255 arm

•  If you are upgrading from RAPL-II to CROS/RAPL-3, you will need to
check the controller. See the relevant section in the CROS and System
Shell. An older controller may need a hardware upgrade.

Cable
You need a cable to connect the computer to the controller. It must be:
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•  Straight-through (not null modem).

•  Controller end, 25 pin (male) connector.

•  Computer end, to fit your serial port. If your computer is recently
manufactured, you likely need a 9 socket (female) connector. An older
computer may need a 25 socket (female) connector.

Multiple Serial Port Expander

You may be using a multiple serial port expander for other devices or
POLARA instruments. We recommend that you avoid the expander for the
connection between the computer and the controller. Use a serial port from
the computer’s mother board or regular serial i/o board.

Robcomm3 and CROS-500
You need Robcomm3 and CROS-500. Depending on your system, they are on
diskettes or CD.

Robcomm3 CROS-500

Stand-Alone Robot 2 diskettes 2 diskettes

POLARA CD-ROM

Installing Robcomm3
Installing Robcomm3 varies depending on your robot system.

•  For a stand-alone robot, you install Robcomm3 from the diskettes
provided with your robot.

•  For a POLARA system, you install Robcomm3 from the POLARA CD,
usually as part of the overall POLARA installation.

Even though the installation procedure is different, it is the same
Robcomm3.

For a Stand-Alone Robot
You can use any one of the three standard methods available from the Start
menu (Run Window, Explorer, or Add Program Utility). The Start menu is
part of your Windows desktop toolbar.

From the Run Window

The Run function is available directly from the Start menu.

1. Insert Robcomm3 diskette 1 in your computer’s diskette drive.

2. From the Start menu, select Run. The small Run window displays.

3. Select the drive and setup file.

•  In the Open box, type the name of the drive and the filename
“setup.exe”, such as
     a:\setup.exe
and click OK.
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•  Click Browse, and from the Browse window, search for the drive and
file named “setup.exe”. After you have selected the file, click Open.

The Robcomm3 installation screen displays.

4. Follow the installation instructions.

From Explorer

Windows 95 Explorer or Windows NT Explorer is available from the Programs
sub-menu of the Start menu.

1. Insert Robcomm3 diskette 1 in your computer’s diskette drive.

2. Start Explorer. From the Start menu, point to Programs and click on
Windows Explorer.

3. Select the drive by clicking on the icon for the appropriate drive.

4. Double-click on “setup.exe”. The Robcomm3 installation screen displays.

5. Follow the installation instructions.

From the Add Program Utility

The Add Program utility is part of the Control Panel which is available from
the Settings sub-menu of the Start menu.

1. Insert Robcomm3 diskette 1 in your computer’s diskette drive.

2. Open the Add Program window. From the Start menu, point to Settings
and click on Control Panel. The Control Panel window displays.

3. Select Add/Remove Programs. The Add/Remove Programs Properties
window displays.

4. From the Install/Uninstall tab, click the Install button.

5. If your system does not locate the drive, click Browse, and from the
Browse window, search for the drive and file named “setup.exe”. After
you have selected the file, click Open.

6. When the path is in the box of the Run Installation Program window,
click Finish. The Robcomm3 installation screen displays.

7. Follow the installation instructions.

For a POLARA System
Install from the POLARA splash screen (the picture of a lab system with the
POLARA logo). You can install only Robcomm3 now and install other
POLARA components later. Or, you can install Robcomm3 with all other
POLARA components now.

Automatically from the CD

The CD is set up to automatically display the POLARA splash screen when
you insert the CD into the CD drive.

If you do not immediately get the POLARA splash screen, you can get to it by
using any one of the three standard methods available from the Start menu
(Run Window, Explorer, or Add Program Utility). The Start menu is part of
your Windows desktop toolbar.
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Manually from the Run Window

The Run function is available directly from the Start menu.

1. Insert the POLARA CD in your computer’s CD drive.

2. From the Start menu, select Run. The small Run window displays.

3. Select the drive and POLARACD file.

•  In the Open box, type the name of the drive and the filename
“POLARACD.exe”, such as
     e:\POLARACD.exe
and click OK.

•  Click Browse, and from the Browse window, search for the drive and
file named “POLARACD.exe”. After you have selected the file, click
Open.

The POLARA splash screen displays.

4. Click on Robcomm3.

5. Follow the installation instructions.

Manually from Explorer

Windows 95 Explorer or Windows NT Explorer is available from the Programs
sub-menu of the Start menu.

1. Insert the POLARA CD in your computer’s CD drive.

2. Start Explorer. From the Start menu, point to Programs and click on
Windows Explorer.

3. Select the drive by clicking on the icon for the appropriate drive.

4. Double-click on POLARACD.exe. The POLARA splash screen displays.

5. Click on Robcomm3.

6. Follow the installation instructions.

Manually from the Add Program Utility

The Add Program utility is part of the Control Panel which is available from
the Settings sub-menu of the Start menu.

1. Insert the POLARA CD in your computer’s CD drive.

2. Open the Add Program window. From the Start menu, point to Settings
and click on Control Panel. The Control Panel window displays.

3. Select Add/Remove Programs. The Add/Remove Programs Properties
window displays.

4. From the Install/Uninstall tab, click the Install button.

5. If your system does not locate the drive, click Browse, and from the
Browse window, search for the drive and file named “POLARA.exe”. After
you have selected the file, click Open.

6. When the path is in the box of the Run Installation Program window,
click Finish. The POLARA splash screen displays.

7. Click on Robcomm3.

8. Follow the installation instructions.
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CROS-500 Requirement
If you are setting up a stand-alone robot, and the controller was delivered
from the factory, complete the next procedure, Installing CROS-500.

If you have any of the following conditions, see the CROS and System Shell.

•  Upgrading a RAPL-II controller to CROS/RAPL-3.

•  Re-installing CROS on a controller.

•  Installing CROS for Windows NT and CROS-500 on a computer as part
of a POLARA installation.

Installing CROS-500
If you are going to write and compile programs to run on the controller,
install CROS-500 on the computer.

For a Stand-Alone Robot
You can use any one of the three standard methods available from the Start
menu (Run Window, Explorer, or Add Program Utility). The Start menu is
part of your Windows desktop toolbar.

From the Run Window

The Run function is available directly from the Start menu.

1. Insert CROS-500 diskette 1 in your computer’s diskette drive.

2. From the Start menu, select Run. The small Run window displays.

3. Select the drive and setup file.

•  In the Open box, type the name of the drive and the filename
“setup.exe”, such as
     a:\setup.exe
and click OK.

•  Click Browse, and from the Browse window, search for the drive and
file named “setup.exe”. After you have selected the file, click Open.

The CROS-500 installation screen displays.

4. Follow the installation instructions.

From Explorer

Windows 95 Explorer or Windows NT Explorer is available from the Programs
sub-menu of the Start menu.

1. Insert CROS-500 diskette 1 in your computer’s diskette drive.

2. Start Explorer. From the Start menu, point to Programs and click on
Windows Explorer.

3. Select the drive by clicking on the icon for the appropriate drive.

4. Double-click on setup.exe. The CROS-500 installation screen displays.

5. Follow the installation instructions.
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From the Add Program Utility

The Add Program utility is part of the Control Panel which is available from
the Settings sub-menu of the Start menu.

1. Insert CROS-500 diskette 1 in your computer’s diskette drive.

2. Open the Add Program window. From the Start menu, point to Settings
and click on Control Panel. The Control Panel window displays.

3. Select Add/Remove Programs. The Add/Remove Programs Properties
window displays.

4. From the Install/Uninstall tab, click the Install button.

5. If your system does not locate the drive, click Browse, and from the
Browse window, search for the drive and file named “setup.exe”. After
you have selected the file, click Open.

6. When the path is in the box of the Run Installation Program window,
click Finish. The CROS-500 installation screen displays.

7. Follow the installation instructions.

Setting Up for Communication
You need to set up for communication if you are going to:

•  transfer files between the computer and the controller.
•  communicate interactively with the controller using the terminal window.
You do not need to set up for communication, if you are only going to:

•  create, edit, and compile programs.

Installing the Cable
Communication uses a straight-through (not null modem) cable. The
controller end of the cable is a DB-25 male/pin connector. The computer end
of the cable must fit your computer’s serial port and most likely needs to be
a DB-9 female/socket connector.

1. Connect the computer end of the cable to a serial port of your computer.
A serial port may be labelled “|O|O|O|”, “serial”, or “com”. If you have
more than one serial port, note the identifying number of this serial port.
(If you are using a multiple serial port expander for many devices, use
one of the computer’s direct serial ports, not a port through the
expander, for Robcomm3.)

2. Connect the controller end of the cable to the communication port inside
the drop-down access door of the front panel of the controller.

Warning.  Do not connect to the SYSIO connector on the rear panel of the
controller.  The SYSIO connector and the communication port are both 25
socket/female connectors. The SYSIO connector connects to controller
operating circuits and includes a live 24 Volt power supply which will seriously
damage you computer circuitry.
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Configuring Communication
Robcomm3’s communication settings must be set correctly.

1. Start Robcomm3. The Robcomm3 main window, which contains the main
menu bar, is displayed.

2. From the C500 menu, choose COM Settings. The Communications Setup
window is displayed.

3. Select the communication port being used by the computer. This is the
computer’s serial port where you connected the cable between the
computer and the controller.

4. Select the baud rate to match the controller. The controller’s default
setting is 38400.

5. Click OK to accept the settings and close the box.

Note: If you set the controller to communicate at a different baud rate, you
will have to set your computer to communicate at the same rate. Setting the
controller’s baud rate with the system shell’s siocfg command is described in
the CROS and System Shell.
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C H A P T E R  3

Editing

One of the primary uses of Robcomm3 is to create and edit a program.
Robcomm3 has features for simplifying the editing process.

This chapter describes how to:

•  Create a new source file or open an existing source file.

•  Use the editing features.

Source File and Object File
RAPL-3 is a compiled language. You write your program in an editor. The file
you write is the source file. It is processed through the compiler, which
translates the file into a form that can be run easily and quickly on the
operating system. This translated file is the object file. Both files are your
program. One file you can read. The other file CROS can execute.

To write the source file, use an editor, like the editor window of Robcomm3.

Opening an Editor Window
When you open an editor window, you can work in a new or existing source
file.

Opening a New Source File
To open a new file:

1. Open an editor window for a new file.

•  Click the New button.

•  Select New from the File menu.

The editor window opens. (The default colouring is white background
with black letters.) “UnTitled” is in the title bar.

Preparing a Directory

If you are using Robcomm3 for the first time, you may want to create a
directory for your RAPL-3 files. Use Explorer or a similar tool to create a
directory.

Naming and Saving a New File

When you initially open a new file, the file has no name (“UnTitled” is in the
title bar), and the file is not set up to be saved (the Save function from the
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Save button and the Save option of the File menu are inactive). Before typing
in this open window, use the Save As function to rename and save your file.

Note: If you have typed any text in the window, the Save function is active.

1. Select Save As.

•  From the File menu, select Save As.

•  If you have typed text in the file, click the Save button.

The Save As dialog box appears.

2. Select the drive and directory to save this file. If you have a standard
robot system, you can save the file in any convenient directory. If you
have a system with CROS for Windows NT, you are likely saving this file
in program files\crs robotics\CROSnt\image\app\directory_name . . . .

3. Type a name over the asterisk in the filename box. For a basic
application, use the same name as your application. The Save As window
will add the .r3 extension. Your source file must have a .r3 extension.

4. Click OK to accept this name. The file name appears in the title bar of
this editor window.

Opening an Existing Source File
If you have an existing file, you can re-open it to work on that file.

To open an existing file:

1. Select the Open Existing File feature.

•  Click the Open button.

•  Select Open from the File menu.

The Open dialog box is displayed.

2. Select the drive and directory of the file. If you have a standard robot
system, you may have files in any convenient directory. The standard
examples are in crs\robcomm3\examples. If you have a system with
CROS for Windows NT, you are likely saving files in program files\crs
robotics\CROSnt\image\app\directory_name . . . .

3. Select a file by:

•  double-clicking on the file

•  highlighting a file and clicking  OK

An editor window opens with the file in it. The file name appears in the
title bar of this editor window.

Using RAPL-3 Features
Robcomm3 has two features specifically for editing RAPL-3 programs:

•  Highlighting of RAPL-3 program elements.

•  Commenting and uncommenting sections of the program.
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Turning Highlighting On or Off
The highlighting feature allows you to highlight different RAPL-3 program
elements. You can turn this on or off.

The setting (on or off) is in effect as long as that editor window stays open. If
you close and later re-open that file, open another file, or close and re-start
Robcomm3, you lose the setting. When you open a file, Robcomm3’s default
setting is used, which is highlighting turned on.

To turn the highlighting on or off:

1. From the Edit menu, choose Options. If there is a check mark to the left
of Syntax Hi-Lite, it is on. If there is no check mark to the left of Syntax
Hi-Lite, it is off. Simply select Syntax Hi-Lite to change the state from off
to on, or on to off.

Changing Colours for Highlighting
You can change the colours for the highlighted text and for the background.
If you change the colour, this change is in effect for all editor windows.

A change is a permanent setting. It is in effect for all subsequent sessions of
Robcomm3. If you close and later re-open that file, or close Robcomm3 and
later re-start it, your settings are used.

To change the colour of the text or the background:

1. From the Edit menu, choose Options. Then choose Colour. The Colour
Selector appears.

2.  Select one of the seven program elements by clicking on it.

3.  Select a colour for that element by clicking on a colour box.

4.  Repeat steps 3 and 4 for any other elements.

5.  Click OK to accept the colours.

Commenting and Uncommenting
In RAPL-3, a comment is preceded by two semi-colons. The comment feature
from the Edit menu automatically adds two semi-colons at the beginning of
any selected line(s).
This feature is helpful while debugging a program. For example, you can
comment out sections of the program, compile for errors and revise until it is
error free, and gradually uncomment sections to add them back to the
portion being compiled and debugged.
As well, you can comment out a section and then a part of that section (or,
conversely, a section and then a group of sections), in effect “nesting”
commented text to exclude those pieces for different steps of debugging.

To comment lines of a program:
1. Highlight the lines of text by dragging the cursor with the mouse or

holding down the Shift key and pressing the Up or Down arrow key. You
only need to highlight part of the line you want to comment.
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2. Select Comment from the Edit menu. Two semi-colons (;;) appear at the
beginning of the lines. If syntax highlighting is turned on, the lines are
greyed out.

To uncomment lines of a program:
1. Highlight the lines of text.
2. Select Uncomment from the Edit menu. Two (only two) semi-colons are

removed from the beginning of each line. If this removes all semi-colons
from a line and if syntax highlighting is turned on, the words in the line
are highlighted according to highlighting colours.

Using Standard Editor Features
Robcomm3 has standard editing features:

•  cut

•  copy

•  paste

•  delete

•  find

•  find next

•  replace

•  undo

Cut and Paste
The Cut and Paste features allow you to remove text from one section and
insert it in another section of that file or in another file.

To cut and paste text in your file:

1.  Highlight the text that you wish to remove.

2.  Cut the text by

•  selecting the Cut command from the Edit menu or from the right-
mouse click menu

•  clicking the Cut button on the toolbar

•  pressing the control (Ctrl) and x keys

3.  Place the cursor in the exact position where you want to insert the text.

4.  Paste the text by

•  selecting the Paste command from the Edit menu or from the right-
mouse click menu

•  clicking the Paste button on the toolbar

•  pressing the control (Ctrl) and v keys

Note: To remove text from your file completely, use one of the cutting options
or press the Delete key on the keyboard.
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Copy and Paste
The Copy and Paste features allow you to duplicate text in another section of
that file or in another file.

To copy text in your file:

1.  Highlight the text that you wish to copy.

2.  Copy the text by

•  selecting the Copy command from the Edit menu or from the right-
mouse click menu

•  clicking the Copy button on the toolbar

•  pressing the control (Ctrl) and c keys

3.  Place the cursor in the exact position where you want the copied text to
appear.

4.  Paste the text by

•  selecting the Paste command from the Edit menu or from the right-
mouse click menu

•  clicking the Paste button on the toolbar

•  pressing the control (Ctrl) and v keys

Delete
The Delete feature allows you to remove text from your document.

To delete text from your document:

1.  Highlight the text you wish to delete.

2.  Delete the text by

•  selecting the Delete command from the Edit menu

•  pressing the Delete key on your keyboard.

The text is removed.

Find
The Find feature allows you to search the open file to locate the text specified
in the Find dialog box.

To find specified text:

1. Select the Find command from the Search menu or click the Find
button.

2. Type the text you want to find in the Find What box.

3. Select the search options (Match Whole Word, Match Case) you want
to use.

4. Specify whether you want to search Up towards the start of the file or
Down towards the end of the file.
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5. Click Find Next to search for the next occurrence of the specified text.
Click Find Next repeatedly to find following occurrences.

6. Click Close to exit.

Options

Match Whole Word Only

Comment lines are not searched when Match Whole Word Only is selected.

Find Next
The Find Next feature allows you to search the open file to find the next
occurrence of the last text string specified in the Find dialog box.

You can continue to click the Find Next feature until there are no more
occurrences of the text, and a dialog box appears stating “No Matches
Found”.

Replace
The replace function allows you to search for specific text in the open file and
replace it with specified text. You can replace all instances of the text or have
the computer prompt you to make the change for each occurrence of the
text. The Replace feature is useful for changing a variable name throughout
the file.

To replace occurrences of selected text:

1. Choose Replace from the Search menu.

2. Type the text you want to search for in the Find What box.

3. Type the text you want to replace the specified text with in the Replace
With box.

4. Select the search options (Match Whole Word, Match Case) you want to
use.

5. Specify the type of search:

•  Click Replace to replace the current instance of the specified text and
locate the next occurrence.

•  Click Replace All to replace all instances of the specified text.

•  Click Find Next to find the next occurrence of the specified text
without replacing the current occurrence.

•  Click Close to exit.

Options

Match Whole Word Only

Comment lines are not searched when Match Whole Word Only is selected.
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Undo
The Undo function allows you to cancel your last action. For example, if you
accidentally delete a section of your program, you can choose the Undo
command from the Edit menu or the Undo button from the toolbar, and the
last action completed will be reversed.

Changing the Display in the Editor Window
You can:

•  change the font used for the text.

•  turn on or off the highlighting feature.

•  change the colours used for highlighting program elements and for the
background.

Turning on or off the highlighting and changing colours are described in the
Using RAPL-3 Features part of this chapter.

Changing Font
You can change the font for a specific editor window. You could change one
editor window to one font and another editor window to another font.

A change is in effect as long as that editor window stays open. If you close
that editor window, or close Robcomm3, you lose the changed font settings.
When you open the file the next time, Robcomm3’s editor window default
settings are used.

To change the font of the text:

1. From the Edit menu, choose Options.  Then choose Font. The Font dialog
box appears.

2.  Select a font, style, size, and script by clicking on each. An example is
displayed in the Sample box.

3.  Click OK to accept the selection.

Saving and Closing Files
You can save a file at any time. When you close an editor window,
Robcomm3 prompts you for saving, if you have made changes since the last
save.

Saving from a New Editor Window with No Text
If you have just opened an editor window and have not typed any text, you
must use the Save As function to name and save your file.

1. Select Save As from the File menu. The Save As dialog box appears.

2. Select the drive and directory to save this file. If you have a standard
robot system, you can save the file in any convenient directory. If you
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have a system with CROS for Windows NT, you are likely saving this file
in program files\crs robotics\CROSnt\image\app\directory_name . . . .

3. Type a name over the asterisk in the filename box. For a basic
application, use the same name as your application. The Save As window
will add the .r3 extension. Your source file must have a .r3 extension.

4. Click OK to accept this name. The file name appears in the title bar of
this editor window.

From now on, you can use any regular Save function.

Saving from a New Editor Window with Text
If you have just opened an editor window and have typed any text, the Save
function is active.

To save the file:

1. Start the save process by selecting Save from the File menu or from the
right-mouse click menu or by clicking the Save button. The Save As
dialog box appears.

2. Select the drive and directory to save this file. If you have a standard
robot system, you can save the file in any convenient directory. If you
have a system with CROS for Windows NT, you are likely saving this file
in program files\crs robotics\CROSnt\image\app\directory_name . . . .

3. Type a name over the asterisk in the filename box. For a basic
application, use the same name as your application. The Save As window
will add the .r3 extension. Your source file must have a .r3 extension.

4. Click OK to accept this name and save the file. The file name appears in
the title bar of this editor window.

From now on, you can use any regular Save function.

Saving Regularly
Any time that you are editing a file, you can save the file. To save a specific
file, the cursor must be active in that file’s editor window. When it is active,
the editor window’s title bar is the colour of your computer’s setting for
active title bars.

To save the file:

1.  Save the file by

•  selecting the Save command from the Edit menu

•  selecting the Save command from the right-mouse click menu (when
the pointer is over the editor window)

•  clicking the Save button on the toolbar

Saving the Text as a Different File
If you have taken an existing file and altered it, and you want to save it as
another file, you must use the Save As command.
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1. Select Save As from the File menu or from the right-mouse click menu.
The Save As dialog box appears.

2. Select the drive and directory in which to save this file.

3. Type a new name over the existing name in the filename box. The Save
As window will add the .r3 extension. Your source file must have a .r3
extension.

4. Click OK to accept this name. The file name appears in the title bar of the
editor window.

Saving All Open Files
To save all files in all open editor windows:

1.  From the File menu, select Save All.

All open files are saved.

Closing an Editor Window
Robcomm3 prompts you to save as you try to close an editor window. To
close an editor window, the cursor must be active in that editor window.

1. Close the editor window by

•  clicking the Close (X) button in the upper right corner of the window.

•  selecting Close from the menu of the editor program icon in the upper
left corner of the window

•  selecting the Close command from the File menu

•  pressing the control (Ctrl) and F4 keys

2. If you have not saved this file, a dialog box appears, stating “This
document has been changed. Would you like to save it?” If you do not
want to save, click No. If you want to save, click Yes. If you want to
return to the editor window without saving, click Cancel.

Closing All Editor Windows
You can close all editor widows at once.

1. From the Window menu, select Close All.

2. If you made changes since the last save, Robcomm3 prompts you to save
the changes. Robcomm3 prompts you for each unsaved file and identifies
each, by file name and editor number, in the title bar of the saving
prompt box.

Using an Alternative Editor
You do not have to use Robcomm3 to edit a source file.

For example, if you are away from your work site and do not have a
computer with Robcomm3, but have a computer with another editor, you can
write and save source files.



20 Robcomm3: Editing

98-12-23

Considering Options
You can edit a source file using:

•  any text editor such as Notepad

•  any text-with-formatting editor such as WordPad

•  any word processor such as Word or WordPerfect

•  any software developer’s editor such as GNU Emacs.

Saving the File
You must look after some functions that the editor of Robcomm3 looks after
automatically.

Content

If you are using a text-with-formatting editor or a word processor, you must
save the file as an ASCII text file. Saving the file with formatting fills the file
with unwanted characters that cannot compile.

Extension

When you save, you must save the file with a .r3 extension. If you
accidentally save it (or if the editor only allows you to save it) with a .txt
extension, you have to change the extension using a rename function.
Change the extension using a utility such as Explorer or at a command line.

Limiting Features
When you use another editor, you do not have features that are available in
Robcomm3. These include:

•  RAPL-3 keyword highlighting

•  commenting/uncommenting using RAPL-3’s two semi-colons
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C H A P T E R  4

Compilation

RAPL-3 is a “compiled” language. You write your program in an editor. This
file is the source file. This file is processed through the compiler which
translates the file into a form that can be run easily and very fast on the
operating system. This file is the object file. Both files are your program. One
file you can read. The other file CROS can execute.

Preparing to Compile
There is only one action you must perform before compiling.

Naming a File
Robcomm3 will compile a file, a program that has a name in the title bar of
the editor window. If you have written a program in an editor window, but
never created a file by giving it a name, by using the Save As feature,
Robcomm3 will not compile it.

To turn your lines of editing into a file:

1. Select Save As.

•  From the File menu, select Save As.

•  If you have typed text in the file, click the Save button.

The Save As dialog box appears.

2. Select the drive and directory to save this file. If you have a standard
robot system, you can save the file in any convenient directory. If you
have a system with CROS for Windows NT, you are likely saving this file
in program files\crs robotics\CROSnt\image\app\directory_name . . . .

3. Type a name over the asterisk in the filename box. For a basic
application, use the same name as your application. The Save As window
will add the .r3 extension. Your source file must have a .r3 extension.

4. Click OK to accept this name. The file name appears in the title bar of
this editor window.

Your program now has a name and is in a directory.

Not Having to Save Your File
Before compiling, you do not have to manually save the latest edits of your
program. When compile your program, Robcomm3 automatically saves your
edits and uses that just-saved file when it compiles.
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Compiling
Compiling takes your source file and translates it into an object file.

To compile:

1. Make sure that the file you want to compile has its editor window active.
The active editor window has its title bar in a colour. If you have more
than one editor window open, or if you have a terminal window active,
click anywhere on the file’s editor window to make it active.

2. Compile your file by

•  selecting the Compile command from the Application menu or from
the right-mouse click menu

•  clicking the “R3” Compile button on the toolbar

In Robcomm3’s status bar (along the botton of the Robcomm3 main
window), the message “Compiling” is displayed. The time for compiling
depends on the size of your program and the capacity of your computer’s
processor.

3. Finish the compiling task.

•  If the program successfully compiled, the RAPL-3 Compile dialog box
appears. Click OK.

•  If the error window appears, review the errors and warning. See
details in the next section.

If your program successfully compiled, the compiler placed the object file in
the same directory as your source file.

If your program did not compile because Robcomm3 could not find the
compiler, see the Troubleshooting section of this chapter.

If your program did not compile because the program had errors, see the
Handling Errors and Warnings section of this chapter.

Handling Errors and Warnings
Errors and warnings assist you in de-bugging your program.

Understanding Errors and Warnings
The RAPL-3 compiler has two categories of messages.

Error

An error indicates a problem so serious that your program cannot compile.
Errors include improper syntax such as: command names that do not exist;
opening brackets without closing brackets; a looping construct that was
started but never finished.

Every error must be corrected. Often, for one error in the program, the
compiler displays several error messages.

Warning

A program compiles if it has warnings (and no errors).
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A warning draws attention to a part of the program where you wrote in a way
that might, or might not, be what you wanted the program to do. The
compiler draws attention to it for you to check.

For example, you get a warning if you do not use a variable that you
declared. This is acceptable if you are still developing your program, have not
yet written the part that uses the variable, and want to de-bug the existing
part of the program. This is a problem needing to be corrected, if you copied
a section of the program, but did not yet change the new section to use the
new variable.

For another example, you get a warning if you implicitely declare any
variable. Any implicitely declared variable without a prefix is declared as an
integer. This is acceptable if you wanted that variable as an integer. This is a
problem needing to be corrected, if you did not insert the prefix and wanted
the variable as a float.

Viewing Errors and Warnings
The error window displays errors and warnings in the following way.

Each line describes one error or warning.

The error/warning line displays the name of the program, the line in the
program with the error or warning, and the description of the error or
warning.

Simplifying Complex Compilation
When you are developing your application, you are editing and compiling
repeatedly.

If you want to

•  compile a master program while editing one or more included files

•  compile with libraries

•  compile to an object file with a name different from the source file

•  change compiler options

you can configure settings for this to happen automatically each time you
compile.

See the chapter on Application Setups.
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Selecting Compiler Options (Robcomm3)
If you use the Application Setup feature, you can set different compiler
options. You can specify any options from the following table.

General Options

Syntax Description Example

-E
Preprocess only. Do not compile.

-n nothing
Print commands but do nothing.

-nolibs no libraries
Do not automatically load any libraries.

-tdir temporary directory
Place temporaries in directory dir.

-v verbose
Print commands before execution.

Preprocessor Options

Syntax Description Example

-Dname define name
Define name as a macro with definition 1.

-Dname=def define name = definition
Define name as a macro with definition def.

Preprocessor commands are described in the Preprocessor chapter of the RAPL-3 Language
Reference Guide.

Compiler Options

Syntax Description Example

-fnat no automatic teachables
.

-fnimp no implicit declarations
No implicit declarations allowed.

-fstack=NNNN Suggest minimum stack size (in words).
Default is CROSnt     1000 words
                CROS-500  384 words

-fstackck stack check
Produce extra stack checking code.

-l line numbers
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[lowercase letter l] Include line numbers (even if stripping).

-Lmodulename
[uppercase letter L]

link modulename
Include module "modulename" during
complation.

-O0
[letter O, number zero]

optimize 0
Do not perform any optimization.

-O1
[letter O, number one]

optimize 1
Optimize jumps and remove dead code.

-s strip
Strip all symbols from output module.

-Wmax warn maximum
Warn on anything even remotely questionable.

-Wall warn all
Warn on all possible problems.

-Wnone warn none
Do not give any warnings.

-x exclude
Exclude all but essential symbols from a library.

Compiling from the Command Line
You do not have to use Robcomm3 to compile. You can compile from the
command line.

For example, if you are away from your work site, have a computer, and have
CROS-500 or CROSnt, but not Robcomm3, you can compile your files.

The filename of the RAPL-3 compiler is r3c.exe.

During installation, the installation utility installed the compiler in
     system_drive\program files\crs robotics\rapl-3\bin
such as
     C:\program files\crs robotics\rapl-3\bin
unless you specified a different drive or directory during installation.

Setting Up Your Computer
To compile from the command line, you must:

•  set an environment variable, the path to the compiler, so that you can
compile from any directory, or

•  always compile from the directory with the compiler, but use compete
pathnames for the source file and the object file

Setting the environment variable for the path is the preferred option.

Windows NT

In Windows NT, you check or change the path from a system dialog box.

To add the path:
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1. From the Start menu, select Settings, then Control Panel, then System.
The System Properties dialog box appears.

2. Select the Environment tab.

3. Modify the path

•  If you have a variable called PATH, Path, or path

a) Select it by clicking on it. The name, path, appears in the Variable
box and the settings appear in the Value box.

b) In the Value box, cursor to the end of the line, add a semi-colon
(;) and the path to the compiler, for example
; C:\program files\crs robotics\rapl-3\bin

•  If you do not have a variable called PATH, Path, or path, .

a)   Place the cursor in the Variable box by clicking on it. Type the
name
path

b)  Place the cursor in the Value box by clicking on it. Type the path
to the compiler, for example
C:\program files\crs robotics\rapl-3\bin

You can now compile a RAPL-3 program from any directory.

To check that the path setting is working:

1. Open a command line window on your computer’s operating system.
From the Start menu, select Programs, then (MS-DOS) Command
Prompt.

2. Enter
     r3c
for the RAPL-3 compiler. Without any files to process, the compiler
displays compiler options.

Windows 95

In Windows 95, you check or change the path by editing your computer’s
autoexec.bat file, located at the root (highest) level of your system drive (on
most computers, the C: drive).

To add the path:

1. Before you begin, make a back-up copy of your autoexec.bat file. Use a
utility such as Explorer to copy and paste the file.

2. Start a text editor such as Notepad. From the Start menu, select
Programs, then Accessories, then Notepad. The Notepad editor window
appears.

3. Open the autoexec.bat file located at the system drive root level, C:.

4. Add the path

•  If you have a line with SET PATH:

 On the SET PATH line, cursor to the end of the line, add a semi-colon
(;) and the path to the compiler, for example
; C:\PROGRAM FILES\CRS ROBOTICS\RAPL-3

•  If you do not have a line with SET PATH:
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Add the entire line
SET  PATH=C:\PROGRAM FILES\CRS ROBOTICS\RAPL-3

5. Save autoexec.bat file. Close the file and exit out of Notepad.

6. Re-boot your computer.

You can now compile a RAPL-3 program from any directory.

To check that the path setting is working:

1. Open a command line window on your computer’s operating system.
From the Start menu, select Programs, then (MS-DOS) Command
Prompt.

2. Enter
     r3c
for the RAPL-3 compiler. Without any files to process, the compiler
displays compiler options.

Compiling
This procedure assumes that you have set the path so that you can compile
from any directory.

To compile from the command line:

1. Open a command line window on your computer’s operating system.
From the Start menu, select Programs, then (MS-DOS) Command
Prompt.

2. Change to the directory where your source file is. For example
     cd  crs\robcomm3\myapp
     cd  program files\crs robotics\crosnt\image\app\myapp

3. Enter the r3c command with the name of the sourcefile and any options
including the name for the object file. For example
     r3c  myapp.r3  -omyapp  -Wall

Selecting Compiler Options (Command Line)
From the command line, you can use more options than you can from the
Application Setup feature. You can specify any options from the following
table.

Order
You can use more than one option at a time and list options in any order.

Limitation
The line for compiler options is limited to 1024 characters.

General Options

Syntax Description Example
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-afile arguments from file
Take the rest of the arguments from file.

-acompop1  (with arguments
in text file named compop1)

-E
Preprocess only. Do not compile.

-ofile output
Place output in file.

-efile errors
Place errors in file.

-h help
Print the help message.

-n nothing
Print commands but do nothing.

-nolibs no libraries
Do not automatically load any libraries.

-tdir temporary directory
Place temporaries in directory dir.

-v verbose
Print commands before execution.

Preprocessor Options

Syntax Description Example

-Dname define name
Define name as a macro with definition 1.

-Dname=def define name = definition
Define name as a macro with definition def.

Preprocessor commands are described in the Preprocessor chapter of the RAPL-3 Language
Reference Guide.

Compiler Options

Syntax Description Example

-fnat no automatic teachables
No variables made teachable by default.
Allow only variables declared with the
teachable keyword. See the Data Types and
Variables chapter in RAPL-3 Language
Reference Guide.

-fnimp no implicit declarations
No implicit declarations allowed.
Allow only explicitely declared variables. See
the Data Types and Variables chapter in RAPL-
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3 Language Reference Guide.

-fstack=NNNN stack
Suggest minimum stack size (in words).
Default is  CROSnt      1000 words
                 CROS-500    384 words

-fstackck stack check
Produce extra stack checking code.

-l
[lowercase letter l]

line numbers
Include line numbers (even if stripping).

-Lmodulename
[uppercase letter L]

link modulename
Include module "modulename" during
compilation.

-O0
[letter O, number zero]

optimize 0
Zero optimization. Do not perform any
optimization.

-O1
[letter O, number one]

optimize 1
Optimize jumps and remove dead code.

-s strip
Strip all symbols from output module.

-Wmax warn maximum
Warn on anything even remotely questionable.

-Wall warn all
Warn on all possible problems.

-Wnone warn none
Do not give any warnings.

-x exclude
Exclude all but essential symbols from a library.

Troubleshooting
The following are the most common problems.

RAPL3BASE
Problem from Robcomm3:  Compile Dialog Box: “ . . . RAPL3BASE . .  ”

You try to compile and get the RAPL-3 Compile dialog box with the message,
“Environment variable RAPL3BASE must be set.”

Problem from Command Line:  “. . . 0:WARNING . . .”

You try to run the compiler and you get the message, “r3c:0:WARNING:
Cannot open configuration file . . . ”

If, when you try to cd to %RAPL3BASE%, the prompt does not change to any
directory.
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Solution

The path to modules needed by the compiler and related processes, the
RAPL3BASE environment variable, is not set. Set this environment variable.

Not Compiling: No Proper Path
Problem from Robcomm3:  Compile Dialog Box: “Compile Error”

You try to compile and get the RAPL-3 Compile dialog box with the message,
“Compile Error.” (This message may indicate this or another problem.)

Problem from Command Line:  “. . . not a command, program, or batch file”

You try to run the compiler and you get the message, “The name specified is
not recognized as an internal or external command, operable program, or
batch file.”

Solution

The path to the compiler is not set. For Windows NT change your
environment variable. For Windows 95, edit your autoexec file. See Setting Up
Your Computer in this chapter.

 “Incompatible”: Programs Not Running
Problem from Terminal:  “. . . signature incompatible . . .”

You try to run a program on the C500 controller and get the message,
     syslib: signature incompatible
     System has CROS500 1.13 loaded; host configuration must
match

The controller is running one version of CROS and you compiled your
program with a different version of CROS. One must have been upgraded to
a higher version. Both must be the same for the program to run. Either the
higher version on the computer must be transferred to the controller, or, the
version on the computer must be changed back to match the version on the
controller.
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To determine which version is installed on the controller:

1. Make sure that Robcomm3 is started, and a terminal window is open,
and the controller is running.

2. At the system shell prompt ($), enter
     crosver
The version of CROS running on the controller is displayed.

To determine which version is installed on the computer:

•  For standard robot installations:

1. Make sure that Robcomm3 is started.

2. From the C500 menu, select Version. The CROS-500 Version Info
dialog box appears.

3. Note which CROS version is installed.

If version info is unavailable, for example, if you get the message “Cannot
open C:\Progra~1\CRSRob~1\CROS-5~1\version.mak”, use an editor
such as NotePad and open the file C:\Program Files\CRS
Robotics\CROS-500\version.mak. The information
“DIST_NAME=CROS500  DIST_MAJOR=1  DIST_MINOR=13” means
CROS-500 1.13.

•  For POLARA users who installed CROS-500 Compact:

1. Start CROS for Windows NT.

2. At the system shell prompt ($), enter
     crosver
The version of CROSnt is displayed.

3. Note the “minor” number (the number after the decimal point). These
must match. The “major” number (the number before the decimal

The CROS 500 Version dialog box, available from Robcomm3’s C500/Version
menu, indicating the version of CROS installed on your computer.
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point) does not have to match. For example, CROSnt 2.13 is
compatible with CROS-500 1.13.

Solution 1:  Upgrade CROS on the Controller

Upgrade CROS on the controller to match the version of CROS on the
computer. Follow the upgrading instructions. They are detailed within, or
immediately after, the CROS and System Shell.

Since all files on the controller will be erased, make sure that you back up,
off the controller:

•  configuration files: \conf\robot.cal, \conf\robot.cfg, \conf\servogrip.cal

•  variable files: any variable file (with a .v3 extension) which is where your
locations are stored

•  \conf\rc if you changed it

Solution 2:  Upgrade CROS on the Computer

Upgrade CROS on the computer to match the version of CROS on the
controller. Follow the instructions for removing and then adding
(uninstalling and then installing) CROS-500 on your computer. These
instructions are detailed beside the Robcomm3 installation instructions in
this Robcomm3 part of this Application Development Guide, and also beside
the CROS on C500 upgrade instructions within, or immediately after, the
CROS and System Shell part of this Application Development Guide.

Make sure that you re-compile:

•  your program

•  any user-defined libraries and user-defined commands in \bin
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C H A P T E R  5

File Transfer

Preparing the Controller to Receive the File
Before you send a file to the controller, you need a directory to send the file
to. You must do this at the system shell prompt ($) before sending the file.

Before you begin, make sure that you:

•  Opened the terminal window

•  Powered on the controller

•  Have a system shell prompt ($)

Are at the root directory. You can check this by entering the command pwd.
If the terminal displays a / (slash), then you are at the root directory. If you
are at any other directory, enter cd .. (cd space dot dot) to move up to the
root directory.

To make a directory, [relative path]
Change directories down to the application (app) directory, by entering

     cd app

Make a directory, by entering

     mkdir directory_name

For example

     mkdir dispense

Check that the directory exists by entering

     dir

Your new directory is listed with all other existing directories.

Transferring a File

1. From the C500 menu in Robcomm3, choose File Transfer.  The File
Transfer dialog box appears.

2. The directories currently on your computer are listed on the PC (left) side.
The directories currently on the controller are listed on the controller
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(right) side.  Highlight the directory which contains the file you want to
transfer from your computer to the controller.

3. On the left side is a list of the files found in the directory highlighted.
Highlight the file you want to transfer.

4. On the right side, highlight the directory that you want to transfer the file
to.  A list of the files currently in that directory will be listed.

 NOTE: You can transfer more than one file at a time. To highlight
multiple files, hold down the CTRL key on the keyboard while using your
mouse to highlight the files you wish to transfer.

5. There are two arrow keys in the middle of the dialog box. Once you have
highlighted the files on your computer (PC) that you wish to transfer, and
you have highlighted the chosen directory on the controller to transfer
the files to, click on the arrow pointing to the controller side of the dialog
box. A screen will quickly show you the transfer of information from your
computer to the controller. The files will then be listed under the
controller directory.

6. Once you have completed the file transfer, click the Exit button.

Simplifying File Transfer
When you are developing your application, you are repeatedly transferring
your file to the controller to run it.

If you want to

•  create a directory on the controller (if one is not already there)

•  transfer the file, specifying the file and directory on your computer and
the directory on the controller

you can configure settings for this to happen automatically each time you
send.

See the chapter on Application Setups.

Transferring Other Files
You can transfer other files such as variable files and configuration files to
the controller by using the File Transfer command from the C500 menu in
Robcomm3.

Use the File Transfer dialog box to transfer these files. Refer to the
Transferring a File section of this manual for complete details.

Backing-up Files
If you want to back up files from the controller, you can.

When you install a new version of CROS on the controller, you erase the
existing version of CROS, including all the files on the controller. To preserve
these files, back them up by transferring them from the controller to the
computer.
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Create a directory on your PC just for this back-up, in order to avoid any
confusion later.

Use the File Transfer command from the C500 menu to transfer files from
the controller to the computer.  Repeat this procedure to copy all necessary
files. Refer to the Transferring a File section of this manual for complete
details.
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C H A P T E R  6

Application Setups

The Application (App) Setup feature allows you to simplify:

•  compiling the source file to an object file

•  making an application sub-directory on the controller

•  transferring the object file to the controller.

After you have defined the app, you:

•  do NOT have to use the command-line to specify compiler options

•  do NOT have to manually make a sub-directory on the controller

•  do NOT have to transfer the object file with the file transfer utility

and setup information is stored for future re-use.

Defining an App
Defining an app specifies the settings.

You create an app for each robot application; in other words, for each main
program.

Creating a New App
Creating a new app gives a name to the app and creates a file to store the
app setup information.

1. From the Application menu, choose New App. The New Application
Configuration window is displayed.

2. Select the drive and directory to save this file. For a basic application,
specify the same directory where you are saving your program source file
and object file.

3. Type a name over the asterisk in the filename box. For a basic
application, use the same name as your program source file. The New
App window will add the .app extension to differentiate this file from the
other files with the same name.

4. Click OK to accept this name. The name appears in the title bar of the
main Robcomm3 window and in the Robcomm3 taskbar button in your
main Windows taskbar.
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Setting Up the App
The Application Setup window captures settings for this app.

If you first created a new app, the Setup window inserts default names and
options. For a basic application, you just click OK.

If you did not first create a new app, you can still setup the app by typing in
names and options and use it for compiling and sending, but these settings
will not be saved for future use.

1. From the Application menu, choose Setup. The Application Setup window
is displayed.

2. If necessary, modify the four settings as described in the following
paragraphs.

3. Click OK to save these settings.

Source File

This is the name of your program in source file format. For a basic
application, use the same name as the app. This source file has a .r3
extension.

C500 Directory

This is the directory on the controller where your object file is sent. To use
the application shell to teach locations, you must select a sub-directory of
the \app directory. For a basic application, use the same name as the app,
source file, and object file.

If you do not specify a C500 directory, Robcomm3 sends your file to the root
(\) directory on the controller, when you send.

Object Name

This is the name of your program after you compile it into object file format.
For a basic application, use the same name as the app and the source file.
This object file has a no extension.

Compile Options

This is the option used when compiling. For a basic application, use -Wall
which displays all warnings. You can change this to any of the options listed
in the Compiling chapter.

Opening an Existing App
If you have an existing app, you can re-open it to work on that application
either with the saved settings or with new settings.

1. From the Application menu, select Open App. The Select Application
Configuration window is displayed.

2. Select the drive and directory and select the app by name.

3. Click OK. The name appears in the title bar of the main Robcomm3
window and in the Robcomm3 taskbar button in your main Windows
taskbar.
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Editing
You edit your program in the same way as any other program.

1. Open the file in an editor window. Edit as necessary.

Compiling and Sending from an App
With the settings saved in the app setup, compiling and sending is
simplified.

As long as an app is open, compiling and sending is done on the files
specified in the app setup. It does not matter what source files are open in
any editor windows.

Compiling
Compiling is done according to the option saved in the App Setup setting.

To compile the source file to an object file:

1. Compile the file.

•  From the toolbar, click the Compile button.

•  From the Application menu, select Compile.

•  From any editor window, right mouse click which will display the
working menu, and select Compile.

While compiling, the message “Compiling” is displayed in the status bar
of the main Robcomm3 window.

2. If compiling is successful, the RAPL-3 Compile window displays the
“Compile OK” message. Click OK. Your compiled object file (with the
name you specified in the app setup) is in the same directory as the
source file.

If there are errors or warnings (which are displayed according to the
option you set in the app setup), correct the source file and try compiling
again.

Sending
With App Setup you do NOT have to make a sub-directory in the \app
directory on the controller before sending your program. The App Setup
utility automatically makes the sub-directory, if there isn’t one already.

With App Setup, you do NOT have to use the File Transfer utility (selecting
the file on the computer, selecting the directory on the controller, and
transferring the file). The App Setup utility automatically takes the object file
and sends it to the controller.

To send the object file from the computer to the controller:

1. Send the file.

•  From the toolbar, click the Send App button.

•  From the Application menu, select Send.
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•  From the active editor window, right mouse click which will display
the working menu, and select Send.

POLARA Developers

If you are writing and compiling for CROS for Windows NT, you normally do
not need to send files to the controller.

Closing an App
If you want to work on another app, close this app.

1. From the Application menu, select Close App. The app name is removed
from the title bar of the main Robcomm3 window and from the
Robcomm3 taskbar button in your main Windows taskbar.

Working with a Multiple-File Program
The App Setup feature is helpful when working on a program that is
composed of multiple files.

You can edit the various source files in editor windows and compile the
entire program according to the settings in the app setup.

How to Write with Multiple Files: Quick Review
In the component file, write that component’s portion of code. For example:

;; messages.r3

sub message_one()
print(“Hello \n”)

end sub

In the main file, include the component file using the .include keyword. For
example:

;; application_with_multiple_files.r3

.include messages.r3

main
message_one()

end main

The preceding two files are the equivalent of:
;; application_with_single_file.r3

sub message_one()
print(“Hello \n”)

end sub

main
message_one()

end main

which has the same result as:
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;; application_as_one_function.r3

main
print(“Hello \n”)

end main

For other details, see the RAPL-3 Language Reference Guide.

Setting Up the Program for Compiling
Make sure that App Setup is set to compile the file with the main function.

1. Open the app.

2. Access the settings. From the Application menu, choose Setup.

3. Ensure that the source file is the file with the main function and all other
settings are what you want.

4. Click OK to save these settings.

Editing Files and Compiling the Program
To edit and compile:

1. For each component file that you want to edit, open the file in an editor
window. Edit as necessary.

2. To compile the program.

•  From the toolbar, click the Compile button.

•  From the Application menu, select Compile.

•  From any editor window, right mouse click which will display the
working menu, and select Compile.

While compiling, the message “Compiling” is displayed in the status bar
of the main Robcomm3 window.

3. If compiling is successful, the RAPL-3 Compile window displays the
“Compile OK” message. Click OK. Your compiled object file (the whole
program) is in the same directory as the source file of the main file.

If there are errors or warnings, they are displayed with the component
filename at the beginning of the line.

Compiling Individual Files
You can still edit and compile an individual component file. Simply close the
App and compile the component file from its active editor window. Any time
you compile a file with App closed, the compiler compiles only the file in the
active editor window and places the object file in the same directory as the
source file.

When you want, open the App, set up the App, and compile the whole
program.
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Working with Libraries
The App Setup feature is helpful when working on a program that uses
library files.

How to Write with Libraries: Quick Review
A library is a RAPL-3 program that can be used by other programs.

In the library file, write the code that is going to be used by various
programs. For example:

;; messages.r3

sub message()
print(“Goodbye \n”)

end sub

In your program, call the library subroutine, function, or command.  For
example:

;; application_calling_library_sub.r3

main
message()

end main

For programs with libraries to work you need to write and compile in the
following way.

Setting Up the Library
Make sure that App Setup is set to compile the library and send it to the
proper directory.

1. Open the app for the library.

2. Access the settings. From the Application menu, choose Setup. The
Application Setup window is displayed.

3. Modify the four settings as described in the following paragraphs.

4. Click OK to save these settings.

Source File

This is the same as the standard setup. This is the name of the library in
source file format and has a .r3 extension.

Compile Options

Use the -x option, which keeps essential symbol information, but excludes
unnecessary extra symbol information. Do not use the -s option which
excludes all symbol information.

Object Name

Add a .r extension, which is the standard RAPL-3 library extension.
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C500 Directory

Set the C500 directory to the \lib directory. The RAPL-3 interpreter looks in
the \lib directory for a library used by any program.

Editing, Compiling, and Sending the Library
To edit and compile:

1. For the library file that you want to edit, open the file in an editor
window. Edit as necessary.

2. Compile the program.

•  From the toolbar, click the Compile button.

•  From the Application menu, select Compile.

•  From any editor window, right mouse click which will display the
working menu, and select Compile.

While compiling, the message “Compiling” is displayed in the status bar
of the main Robcomm3 window.

If compiling is successful, the RAPL-3 Compile window displays the
“Compile OK” message. Click OK. Your compiled object file is in the same
directory as the source file.

If there are errors or warnings, they are displayed with the component
filename at the beginning of the line.

3. Send the library file to the \lib directory.

•  From the toolbar, click the Send App button.

•  From the Application menu, select Send.

•  From the active editor window, right mouse click which will display
the working menu, and select Send.

4. Close the app for the library.

Finishing with Libraries
Repeat the above procedures for each library file.

Setting Up Your Program
Make sure that App Setup is set to compile the file with the main function.

1. Close any currently open app, such as the app for the library.

2. Open the app for the program.

3. Access the settings. From the Application menu, choose Setup.

4. Modify the four settings as described in the following paragraphs.

5. Click OK to save these settings.
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Source File

This is the same as the standard setup. This is the name of the program in
source file format and has a .r3 extension.

C500 Directory

This is the same as the standard setup. This is the directory on the
controller where your object file is sent. To use the application shell to teach
locations, you must select a sub-directory of the \app directory. For a basic
application, use the same name as the app, source file, and object file.

Object Name

This is the same as the standard setup. This is the name of your program
after you compile it into object file format. For a basic application, use the
same name as the app and the source file. This object file has a no
extension.

Compile Options

Compile with the library module by using the -L option, such as -Lmodule.r
or -Lmessages.r. List all needed libraries.

Editing, Compiling, and Sending Your Program
To edit and compile:

1. Open the program file in an editor window. Edit as necessary.

2. Compile the program.

•  From the toolbar, click the Compile button.

•  From the Application menu, select Compile.

•  From any editor window, right mouse click which will display the
working menu, and select Compile.

While compiling, the message “Compiling” is displayed in the status bar
of the main Robcomm3 window.

If compiling is successful, the RAPL-3 Compile window displays the
“Compile OK” message. Click OK. Your compiled object file is in the same
directory as the source file.

If there are errors or warnings, they are displayed.

3. Send the program to your sub-directory of the \app directory.

•  From the toolbar, click the Send App button.

•  From the Application menu, select Send.

•  From the active editor window, right mouse click which will display
the working menu, and select Send.

Not Using an App
If you do not create a new app or open an existing app, the default setup
settings are used. They are:
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Source File

The file in the active editor window.

Compile Options

-Wall

Object Name

The same name as the source file with no extension.

C500 Directory

\app\test

Therefore, if no app is set, you compile with -Wall and send to \app\test.
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C H A P T E R  7

Terminal

The Robcomm3 Terminal window provides interactive communication with
the controller. In a terminal session, you can use your computer’s keyboard
and screen as a command line interface to the controller.

Opening a Terminal Window
Before you begin, make sure that:

•  The cable between your computer and the controller (front panel port) is
installed.

•  Robcomm3 is started.

•  Robcomm3 is configured to open the computer’s serial port that the cable
is connected to. (To configure, see the section Configuring Communication
in the chapter Installing and Configuring Robcomm3.)
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1. Open a terminal window.

•  Click the Terminal button.

•  Select Terminal from the C500 menu.

The terminal window (black background with white letters) opens.

Using the Terminal Window: Some Basics
One Window at a Time

You can only have one terminal window to the controller open at one time.
Robcomm3 prevents you from opening multiple windows.

If you accidentally start Robcomm3 a second time and try to open a terminal
window from the second Robcomm3, you will get an error message that the
computer’s serial port is busy (with the first session of Robcomm3’s terminal
communication).

Window Numbering

If you close the terminal window and later open a new window, the number
of the new window is one higher than the last one.

Capturing Start-up Information

If you want to capture all the information displayed by the controller when it
starts up, open the terminal window before powering on the controller.

No Prompt

If, when the controller is already on, you open the terminal window and do
not immediately see a prompt, press the Enter key to get a prompt.

Junk Characters

If, when you open the terminal window and press the Enter key, you get junk
characters, the baud rate of Robcomm3 is different from the baud rate of the
controller. Change the baud rate at Com Settings from the C500 menu.

Using Tools through the Terminal
The terminal allows you to use the system shell and the application shell. It
can also allow you to use the teach pendant.

System Shell
The system shell allows you to enter operating system commands. Using
these commands, you can:

•  Manage directories, files, and devices, including:
•  List directories and files
•  Move, copy, and delete files
•  Display the contents of a text file

•  Monitor processes (programs that are running), including:
•  Display the status of all processes



Robcomm3: Terminal 49

98-12-23

•  Terminate a process
•  Manage memory, including:

•  Display space in memory or on file system
•  Flush buffers and defragment memory

•  Configure and maintain the robot, including:
•  Configure the number of axes, units of measurement, and gripper

type
•  Calibrate axes
•  Calibrate a servo-gripper

•  Setup and move the arm in a limited way, including:
•  Home the arm
•  Move the arm to standard positions like ready and calrdy
•  Limp the arm

For details on the system shell, see CROS and the System Shell.

Application Shell
The application shell allows you to work with the locations and other
variables of a specific application program. Using these commands you can:

•  Move the arm in many ways, including:
•  Move the arm by individual joint
•  Move the arm along or around a world axis
•  Move the arm along or around a tool axis
•  Move to an approach or depart position
•  Limp the arm
•  Move to a known location
•  Move the arm to standard positions like ready and calrdy

•  Manipulate locations and other variables:
•  Teach locations
•  Set values to other variables
•  Create and delete variables

•  Configure arm motion, including:
•  Set linear speed
•  Set accelerations

•  Modify co-ordinate systems, including:
•  Set a base offset
•  Set a tool transform
•  Modify a location in a co-ordinate system

•  Setup arm and display status, including:
•  Home the arm
•  Display positional data



50 Robcomm3: Terminal

98-12-23

•  Operate the gripper, including:
•  Open and close the gripper
•  Open the gripper to a specific distance

•  Use i/o, including:
•  Set outputs
•  Display inputs

For details on the application shell, see the Application Shell Guide.

Teach Pendant
The teach pendant is the hand-held equivalent to the command-line
application shell. You can move the arm and work with locations and other
variables from the teach pendant’s hand-held keypad.

From the terminal, you can start up the teach pendant. You can also make
the teach pendant start up automatically, if you modify the controller’s rc
file.

For details on the teach pendant, see the Teach Pendant Guide.

Installing an Alternative Terminal
You do not have to use Robcomm3 to communicate with the controller.

For example, if you are at your robot site and do not have a computer with
Robcomm3, but have a computer with a terminal emulator, you can set it up
to communicate with the controller so that you can troubleshoot problems
with the robot.

Considering Options
You can communicate with the controller using:

•  the terminal window of Robcomm3

•  a computer in terminal emulation mode

•  a simple serial terminal.

Limiting Other Functions
Any of these options give you terminal access to the controller. Other
functions (that you need to perform if you are developing an application) are
not possible with just a terminal.

File transfer is only possible with Robcomm3’s file transfer utility.

Using Robcomm3

Function Possibility

Editing Editor window of Robcomm3.

Compiling Compile function from within Robcomm3.
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File Transfer File transfer utility of Robcomm3.

Terminal
Communication

Terminal window of Robcomm3.

Using a Computer with Terminal Emulation

Function Possibility

Editing Any text editor.

Compiling Command line access to compiler.

File Transfer NOT possible.

Terminal
Communication

Terminal emulator’s window.

Using a Simple Terminal

Function Possibility

Editing NOT possible.

Compiling NOT possible.

File Transfer NOT possible.

Terminal
Communication

Terminal screen.

Installing the Cable
You need a cable to connect the controller to the computer or simple
terminal. It can be a ribbon or cord-like cable. It must be:

•  Straight-through (not null modem).

•  Controller end, 25 pin (male) connector.

•  Computer/terminal end, to fit your serial port. If your computer is
recently manufactured, you likely need a 9 socket (female) connector. An
older computer may need a 25 socket (female) connector. A serial
terminal likely needs a 25 socket (female) connector.

All terminal communication uses the communication port located inside the
front panel swing-down access door. The connector is a 25 socket (female)
connector.

Warning.  Do not connect to the SYSIO connector on the rear panel of the
controller.  The SYSIO connector and the communication port are both 25 socket
(female) connectors. The SYSIO connector connects to controller operating circuits
and includes a live 24 Volt power supply which will seriously damage you computer
circuitry.

The front panel communication port is a full RS-232 port with control
signals.

1. Connect the controller end of the cable to the communication port inside
the drop-down access door of the front panel of the controller.
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2. Connect the other end of the cable to the serial port of your computer or
terminal. A serial port may be labelled “|O|O|O|”, “serial”, or “com”. If
you have more than one serial port, note the identifying number of this
serial port.

Setting Up the Terminal
Many computer systems have terminal emulator software as part of their
standard installation. Third-party software is available. You do not need a
modem. (Some terminal emulation software automatically inquires about a
modem.)

Since serial terminals may vary by manufacturer, refer to the terminal’s
documentation for set up.

1. Configure the terminal for controller communication. If you are using
terminal emulation software on a computer, open the software.

•  Com Port:  This is the serial port where you connected the cable. If
you are using a terminal emulator on a computer, there may be a
number of ports.

•  Baud Rate:  Match the rate of the controller. The default rate for the
controller on this port is 38400. If you changed the rate on the
controller, you must change the rate here.

•  Data Bits:  8

•  Parity:  None

•  Stop Bits:  1

•  Flow Control:  None

•  Emulation (if on a computer):  TTY or ANSI, but almost any emulator
is acceptable.

 You may have to close down and then re-start a computer’s terminal
emulation software for these settings to take effect.

2. If it did not start automatically, start a terminal session. With terminal
emulation software, this may be called “Start”, “Open”, or “Connect”.
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C H A P T E R  8

POLARA and Robcomm3

If you are a POLARA user, there are a few points to remember when using
Robcomm3.

Terminals
POLARA operators have two terminals: one to CROS-500 (CROS on the C500
controller) and another to CROS for Windows NT (CROS on Windows NT on
the computer).

Terminal to CROS-500
You can use Robcomm3’s terminal window to communicate with CROS-500,
the operating system on the C500 controller. Normally, POLARA operators
use this terminal only to monitor what processes are running on the
controller.

This terminal does not give any access to CROS on the computer.

Terminal to CROS on NT
You cannot use Robcomm3 to communicate with CROS on the computer.

To communicate with CROS for Windows NT on the computer, you use the
CROSnt Command Prompt window, available when you start up CROS for
Windows NT. Normally, POLARA operators use this terminal to teach
locations, test servers, etc.

Editing and Compiling, but Not Sending
To write and compile programs, POLARA developers can use the editor
windows of Robcomm3, the compiling feature, and some of the App Setup
feature.

Editing
You can use editor windows to write RAPL-3 programs. To run these
programs in the CROS for Windows Nt environment, you save these
programs to directories under \CROSnt.
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Compiling
You can use the compiling feature of Robcomm3 to compile a basic program.
You can also use the App Setup feature to configure options for compiling a
master program after editing included files or libraries.

Not Sending
POLARA developers run their programs on the computer, not on the C500
controller. Do not use the send feature to send your files to the controller.
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